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Increase the separation between the equipment and receiver.
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out on the Radio Interference Regulations of the Canadian Department of Communications. Le present appareil
numerique n'emet pas de bruits radioelectriques depassant les limites applicables aux appareils numeriques de la class
A prescrites dans le Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du Canada.
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Section 1: Getting Started
THANK YOU…
...for choosing an LX610 Color Label Printer. The LX610 Printer will print razor-sharp text and
barcodes, vibrant colors, and even stunning photo-realistic photographs directly onto rolls of labels,
card stock and a variety of other approved media. AND with the built-in digital die cutter you can
cut and create your labels in any size or shape you choose.
This User's Manual is your complete step-by-step guide to quickly and easily setting up and printing
with your new Color Label Printer!

1A Choosing a Good Location
•

Place the Printer on a flat surface in a location with adequate air circulation to prevent
internal heat buildup.

•

Do not place the Printer near heat sources such as radiators or air ducts, or in a place subject
to direct sun light, excessive dust, mechanical vibration or shock.

•

Allow for adequate clearance in front of the Printer to accommodate the printed label stock
as it is leaving the Printer to avoid the possibility of binding or jamming of the label stock.

•

Allow for 6” of clearance behind the Printer to accommodate loop creation during cutting
operations. The area directly behind the Printer must also not be obstructed by USB or
power cables connected to the Printer.

•

Allow for adequate overhead clearance for opening the top cover to allow easy access to the
label stock and ink cartridge. The Printer will require 7 inches (17.78 cm) of additional space
on the top side to completely open the cover (Total = 16.5" or 41.91 cm).
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1B Unpacking and Inspection
While unpacking your Printer, inspect the carton to ensure that no damage has occurred during
shipping. Make sure that all supplied accessories are included with your unit. The following items
are included in the supply box:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Power Adapter and Cord
6’ USB Cable (If other USB cable is used, it must be 6’ (2 M) or less)
Color Dye Ink Cartridge Part Number 53496 (Pigment is also available – Part Number: 53491)
Die Cutting Knife Holder with knife preinstalled
Label roll holders (Assembly required – section 1C)
Large Roll Hub
Small Roll Hub
T8 Allen Key and two screws
Printed documentation

5
5

5
6

7
4
8
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1
2
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1C Installing the Roll Holders
Some light assembly is required before operating the Printer. Follow these instructions to install the
roll holders.
1. Set the Printer on its front so the bottom is facing you.

Notch

2. Install the movable label roll holder by attaching the hooked end on the rail. The bottom of
the holder will fit in the notch on the Printer.
Movable Roll Holder

Tab

Rail
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Movable Roll Holder

3. Slide the Roll Holder to the far right.

Notch

4. Install the roll guide by attaching
the hooked end on the rail. The
bottom of the holder will fit in the
notch on the Printer.

Roll Guide

Roll Guide
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Stop

5. Slide the Guide to the stop.
6. Locate the remaining roll holder with the protruding wire. Connect the wire to the port on
the Printer. Tuck the wire inside the cavity.

Push the wire
into the cavity
as you move the
holder closer to
the notch

Wire
Notch
10

7. Snap the holder in place so the two screw holes line up with the holes on the Printer.

8. Install the T8 screws using the INCLUDED Allen key or a Torx T8 screwdriver.
9. Rotate the Printer back on its feet.
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1D Identifying the Parts
These illustration shows the Printer from various angles so all important parts can be identified.

Control Panel

Front Cover

The Power LED indicates that the Printer is on and ready to receive print jobs.
The Ink LED will illuminate when a cartridge has 10% or less of its ink remaining.
The Pause Button is pressed to pause a job to allow for loading of label stock and ink cartridges. The
Printer pauses after the printing of the current label has finished.
The Feed Button is pressed in order to load label stock if the Printer does not automatically detect
the stock. When stock is loaded each press of the button will cause one label or a few inches to be
fed through the Printer.
The Unload Button is pressed to unload label stock after you receive an End of Roll message in
PrintHub. The Printer will reverse the label stock through the feed area.
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Interior
Die Cutting
Carriage

Knife Collar
Handle

Die Cutter
Ribbon Cable

Die Cutting
Knife

Upper Guide
Shaft

Lower Guide
Shaft

Print Carrier
Ribbon Cable

Pre die-cut
rollers

Print Carrier

Wear Strip

Cutter Wheel
Mechanism
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Die Cutting
Pinch Rollers

Back

Infeed Area

Movable
Throat Guide

Gap Sensor
Adjustment

Power Switch

USB

Power

Fixed Roller
Holder w/
Chip Reader

Fixed Guide
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Movable Roll
Holder

Section 2: Media, Cartridges and Knives
2A Label and Roll Specifications
Two types of media can be used.
1. Digital Die-Cut Labels. If you are using the Printer to digitally die-cut your own shapes and
sizes only Primera label stock can be used. This media comes from Primera with a smart chip
that identifies the media, tracks the percentage remaining and automatically sets the sensor
type to continuous. You will know it is installed when you see the Digital Die-cut Media
percentage in the upper right corner of PrintHub. If you do not see this indication, the digital
die cutter will not be enabled and you will not be able to cut shapes.

Smart Chip

The following media types are currently available from Primera. We will be adding more as
additional types are discovered, tested and validated.
SKU
057212
057211
057215

Media
Gloss BOPP
Premium Gloss Paper
Magnetic Material

Description
Durable Synthetic Polypropylene Media, 150 ft
Premium Paper Media, 150 ft
White Gloss Magnetic Media, 100 ft

Other media cannot be used even if you take the chip from new/old Primera media for the following
reasons:
•
•
•

Old chips cannot be reused once they reach 0% remaining.
Other media has liner that may be too thin. Liner on Primera media is specially created for
our Printer to prevent cut through to the wear strip
The dust created from cutting through the inkjet printable topcoat can be excessive on some
media. This can cause frequent print cartridge clogging and other problems.
15

2. Pre Die-Cut Labels. A wide variety of pre die-cut label stock can be used in the Printer. This
media has the shape already cut on the roll before you load it into the Printer. These are
available from Primera or other companies. Refer to the specifications and settings in the
following sections before ordering custom stock from Primera or any stock from other
companies.
Important! Test all custom-made label stock with the intended Printer before ordering large quantities!
Primera will only assume responsibility for custom label stock ordered from Primera.
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Label width
Liner/media width
Label height/length
Gap between labels
Width of through-hole
Gap Sensor Adjustment
Range (from right edge)
Reflective/Black Mark Width*
Max Outer Diameter (OD)
Inner Core Diameter (ID)
Recommended Total
Thickness
(Liner + Label)**
Distance from edge of media
to edge of label

Max

Min

5” (127mm)

0.5" (13mm)
2.125" (54mm)
0.5" (13mm)
0.10" (2.5mm)
0.25" (6.325mm)
0.40" (10.16mm)

5.125 (130.17mm)
12” (305mm)
10" (253mm)
0.5" (12.65mm)
2.05" (52mm)
(see diagram below)
N/A
6.0"(152.4mm)
3.0" (76.2mm)
.0010” (10 mil)

0.1" (2.54mm)
N/A
3.0" (76.2mm)

Printer assumes 2mm (1/16”) gap. However, this is adjustable
via the left margin offset.

* The Reflective/Black Mark should be opaque to infrared light. The mark should be between the
labels. The end of the mark should correspond with the beginning of the label.
** This is the recommended maximum. There are two factors that determine whether the Printer
will accept any particular stock thickness.
1. The ability for the Printer to pull the paper through the print area.
2. The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply. The fact
that the Printer must read through the backing in die-cut mode will limit the thickness much more
than the Printer's ability to pull the paper through the print area. However, if you adjust opacity
level of the liner enough to allow the label to be seen by the stock sensor, the thickness will only be
limited by the Printer's ability to pull it
Gap Sensor
through the printer area. For these reasons
Adjustment
the weight or thickness of the liner is a
variable that cannot easily be defined.
Primera recommends and uses 40# liner
with all Pre Die-Cut label stock.
It is important to test all label stock with the
intended Printer before ordering large
quantities!

2.05”
0.4”
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Gap Sensor Position Indicator from right
edge of media. The position indicator
corresponds to the ruler NOT the installed
label stock.

Roll Specifications:

Note on Label Orientation: If you are using an applicator to apply your labels, be sure to order label
stock with the correct orientation for your applicator. For example, most applicators will apply the
side of the label first, so you will want to print the labels sideways.
Digital Die Cut Media Notes: Even though the width of the media is 4.75 inches, the drive rollers on
either side prevent printing in the areas indicated. The knurled rollers that bite into the media to
drive it, damage the printable surface in this area. The actual printable area is 4.25 inches.

4.25”
4.75”

Unprintable Area

Printable Area
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Unprintable Area

2B Installing Digital Die-Cutting Label Stock
Digital Die-Cut Labels. If you are using the Printer to digitally die-cut your own shapes and sizes only
Primera label stock can be used. This media comes from Primera with a smart chip that identifies
the media, tracks the percentage remaining and automatically sets the sensor type to continuous.
You will know it is installed when you see the Digital Die-cut Media percentage in the upper right
corner of PrintHub. If you do not see this indication, the digital die cutter will not be enabled and
you will not be able to cut shapes.

Green Hub

Blank Chip Holder

Smart Chip

Black Hub

Die Cuts

Continuous Media

Pre Die-Cut Roll

Digital Die-Cut Roll

(User must install Green Hub)

(Hub/Chip comes preinstalled)
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1. Move the roll holder to the preset position for on demand digital die-cutting (3rd mark from
the left – 1.25”)

Move to third
mark from Left

2. Install the Blue Hub on the open side of the digital die-cutting media.
Note: The green hub is not needed for
digital die-cutting and can be stored in
the notch on the movable holder.

Digital Die Cutting
Media comes with
black hub with green
chip.

Blue Hub
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3. Set the roll in place so that the blue pin sits in the notch on the roll holder.

Blue Pin

Notch

4. Make sure the green chip holder fits in the corresponding green slot on the roll holder.

Green Chip
Holder

Notch
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5. Before feeding the stock you must plug in power and switch on the Printer.

Power Switch

Power Cable
6. Guide the leading edge of the roll into the feed area. Move the blue guide to the far side.
Align the media with the “Continuous Stock” marks in the plastic infeed area.

Blue Guide

Continuous Stock

7. Push until the Printer detects the stock, grabs it and pulls it through the Printer.
22

2C Installing Pre Die-Cut Label Stock
Pre Die-Cut Labels. A wide variety of pre die-cut label stock can be used in the Printer. This media
has the shape already cut on the roll before you load it into the Printer. The plotter cutter is not
used for this label stock. These are available from Primera or other companies.

Green Hub

Blank Chip Holder

Smart Chip

Black Hub

Die Cuts

Continuous Media

Pre Die-Cut Roll

Digital Die-Cut Roll

(User must install Green Hub)

(Hub/Chip comes preinstalled)
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1. Move the roll holder to the approximate position which matches the width of the stock you
are installing. You can always fine tune this later.

2. Install the Green Hub on the right side of the pre die-cut media.
3. Install the Blue Hub on the left side of the pre die-cut media.

Die Cuts

Blue Hub

4. Set the roll in place so that the blue pin sits in the notch on the roll holder.
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Blue Pin

Notch

5. Make sure the green blank chip holder fits in the corresponding green slot on the roll holder.

Blank Chip
Holder

Notch
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Before feeding the stock you must plug in power and switch on the Printer.

Power Switch

Power Cable
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6. Guide the leading edge of the roll into the feed area. Move the blue guide so that it touches
the label stock.

Gap sensor
should intersect
the gap between
labels

Blue Guide

Note the position of the label sensor. Slide
the sensor position indicator so that it
intersects with the gaps between your labels.
For most label stock you will not need to
move this.

Gap Sensor Position Indicator
from right edge of media. The
position indicator corresponds
to the ruler NOT the installed
label stock.

7. Push until the Printer detects the stock, grabs it and pulls it through the Printer.
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2D Replacing the Digital Die Cutting Knife holder
Install the included die cutting knife shown here.
1. Open the cover.
2. Pull out on the blue handle to loosen the knife collar.
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3. Install the knife holder.
4. Push on the knife so it goes all the way down
before pushing the collar in.

5. Push the collar to tighten the knife holder
and allow it to cut.

Correct

Incorrect
29

2E Replacing the Cutting Knife
When a knife is dull it will no longer cut through the label at maximum pressure. You will start to
see ragged cuts or cuts that do not cut all the way through the label material. You can attempt to
increase the pressure but you’ll probably need to replace the knife.
If a knife cuts through the liner and contacts the wear strip it may break the tip of the knife. This
can be seen under 10x magnification using a loupe or magnifying glass. If the tip is broken the knife
must be replaced.

If your knife needs replacement, follow this procedure:

1. Remove the knife holder from the carrier using the instructions from
section 2D.
Knife Holder

2. Rotate the cap of the knife holder counter-clockwise.
3. Remove the knife from the holder. You can tap the holder on a hard
surface to free the knife from the holder.
4. Locate a new knife. Remove the molded plastic cover from the knife. The plastic cap covers
the cutting end of the knife. However, both sides are sharp! The cutting end has an angled
carbide tip. The top end comes to a point so it can be easily centered in
the receiving divot on the knife holder cap.

5. Insert the cutting end into the knife holder.

Centering
Point

6. Using the knife holder cover center the back end of the knife in the
holder. You may need to screw down the cover and reverse it several
times until the knife has been centered. Do not force the cap on the holder. The
carbide tip will break. A very light amount of force is necessary to secure the
knife holder cap.
Replacement Cutter Knife 5 pack Part Number: 074332
Replacement Knife Holder Part Number: 074548
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Knife

Carbide Tip
(Cutting End)

2F Replacing Ink Cartridges
You can replace cartridges at any time or wait for the Low Ink Warning to prompt you to replace
cartridges. You will receive low ink warnings at 10% and 0%. Press the Load/Feed button to continue
printing after you receive this warning.
To change a cartridge, follow this procedure:
1. Open the front cover. That cartridge will automatically move to the right side if it is not
already there.
2. Press or pinch the tab on the front of the cartridge holder.

3. Remove the cartridge.

31

4. Locate a new cartridge and remove it from its packaging. Remove the foil outer package and
the tape covering the nozzles.

5. Place the new cartridge into the empty carriage. Note: When installing the cartridge, tilt the
cartridge at a slight backward angle of approximately 30 degrees.

6. Make sure the cartridge is pushed back far enough so the ridge on the cartridge is behind
the spring-loaded pusher on the lid. Push down on the cartridge. Close the lid on the
cartridge by lightly pressing down from the top until you hear a click.

PUSH DOWN
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2G Adjusting the Gap Sensor Position (Pre Die-Cut Labels Only)
If you are using label stock other than standard square / rectangular die-cut labels such as circular
die-cut labels or through-hole stock use the instructions below to adjust the position of the label
stock gap sensor. The sensor can be adjusted using the slide bar on the back of the Printer. Below
the slide bar is a measurement which represents the distance between the edge of the label stock
and the sensor. Measure the distance from the edge of the label stock to the correct position on the
stock. Set the sensor so the side of the slide bar lines up to this measurement. See dashed line in the
illustration below.
Example: 4” wide oval

Set at 2”

Circular Labels

Important Note: You must adjust the stock sensor
before loading nonstandard label stock.

If you are using Circular Labels you must adjust the stock sensor to correspond with the very top of
the label where the circles are closest together. If the sensor is too far to the right or the left the
Printer will still sense the label but the image may be offset downward because the Printer will start
printing at the wrong position. If you are using stock that has multiple labels across, make sure the
sensor corresponds to a place on the stock that has a label and not a vertical gap
The sensor can only be moved a maximum of 2 inches from the left side of the printable area. This
means that the maximum diameter circular label that can be printed is 4 inches. For circular labels
larger than 4 inches in diameter, you must have a black mark printed on the back of the label stock.
This means that you must change the Stock Sensor Mode to Reflective. The Printer will now look for
the black mark representing the beginning of the next label instead of the die-cut. For more
information on changing the Stock Sensor Mode see section 3C.
33

2H Lamination Mode
Enable "Lamination Mode" in PrintHub and Config Utility. This setting will convert Matte BOPP or
Gloss BOPP digital die-cut material into waterproof labels. With lamination, Premium Gloss stock
will become highly water-resistant to surface water contact. Lamination also protects against
scratching and fading.
This function will slightly change the Printer's operation to allow clear laminate labels to be applied
to the print before it is cut.

Instructions:
1. On PC, open PrintHub. Go to Printer Settings – Advanced Button. Enable Lamination Mode.

2. On a Mac, open the LX610Config Utility. Go to the Alignment tab (third tab), click
Output/Cut. Check Lamination Mode.

3. Go to the XY cutter tab. Increase cut pressure by
25 to account for the extra force needed to cut
through the lamination and the label.

4. Send your label and cut file to the LX610 as you
usually would. It is best to limit page size to correspond with the size of the lamination label
if possible.
34

5. After printing, the label is ejected from the Printer but not cut.
6. At this point, the Printer will wait for you indefinitely while you put a lamination label over
the printed surface. (Purchase of Lamination Labels is required)
7. When you are ready, press the PAUSE button to start the cutting process.
8. After cutting is complete, the page will be ejected and cut according to your output settings.
•

Tip 1 - Use a platform such as a monitor stand positioned in front of the Printer to apply your
lamination labels. The monitor stand height can be set to just under the output of the label.
A height of 5.25" is ideal, but anything between 4 – 5.25 would work.

•

Tip 2 - Use an automated or manual label dispenser to dispense the clear labels to speed up
operations.

•

Tip 3 - Small bubbles in lamination disappear within 24 hours as the adhesive cures.

•

Tip 4 – Print a box around your label to guide lamination label application. (4x3, 3x2, or
4.25x6) The box will be not be seen since you will strip the waste matrix away, but it will help
you determine where the lamination label should be applied.

See this simple video demonstration. More comprehensive video instructions and a knowledgebase
article will be available when this feature is released.

These Lamination Labels are available for purchase:
•
•
•

4” x 3” - https://www.primera.com/4-x-3-clear-lamination.html
3” x 2.5” - https://www.primera.com/3-x-2-5-clear-lamination.html
4.25” x 6” - https://www.primera.com/4-25-x-6-clear-lamination.html
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Section 3 Primera PrintHub (PC Only)
Primera PrintHub is used to interact with the Printer for gathering ink levels, maintenance,
alignment, cost calculation and several other functions. You can use it to manage these functions on
multiple LX610 printers and other Primera label printer models. PrintHub automatically installs with
your printer driver and can be accessed through the printer driver preferences or as a program on
your Windows start menu.
1. Connect the Printer via USB and turn on the power. The PrintHub accesses most of the
information it uses from the Printer itself so the Printer must be turned on and
communicating for the program to be useful.
2. Go to Start - Programs - Primera Technology - Primera PrintHub.

A. Adjust alignment, sensor mode, output mode and advanced settings.
B. If you have multiple Primera printers connected, they will be listed here.
C. Past jobs will show the last 5 jobs along with cost information. Click the document icon to
view a cost report.
D. Application Settings
E. Print Queue shows the currently printing job.
F. Order Link
G. Frequent Activities
H. Current Ink Levels (Ink is displayed in 10% increments. Example 100% to 90% to 80% etc.)
I. Digital Die Cutting Media Status and Remaining Amount (If installed)

36

3A XY Cutter Settings – Cut Offsets, Knife Pressure and Stretch Factor
Cut Offsets, Knife Pressure and Stretch Factor settings can be found in Primera Print Hub on the XY
Cutter Tab.

Cut Offsets If your cut does not line up with your printed image, you can adjust it using the
Horizontal Offset and Vertical Offset settings. Press the Send Test Print to help you determine
which direction to move the offsets or refer to the image below.
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Knife Pressure affects how deep into the media the knife will cut. Ideally you want to cut deep
enough to cut through the label layer on the top but not so deep that you cut through the backing
paper (liner). When you cut through the backing paper your label will not peel cleaning off the
backing paper. You will also score the wear strip under the cutting knife which can cause the knife
tip to break. You will also need to replace the wear strip more often if you cut too deep.
By default, the cutter is calibrated to work with High Gloss Paper Media. However, other media
types will need more or less cut pressure to cut properly.
Each roll of media will have a recommended value to add or subtract from the default baseline
values used for Knife Pressure and Knife Stretch Factor. These values are listed below and printed
on a label attached to the inside of the core.

High Gloss Paper
High Gloss BOPP
Magnetic

Knife Pressure
0
4
22

Stretch Factor
0
0
32

Knife Stretch Factor can be increased or decreased to compensate for different feed thicknesses
and textures of media. Thickness and texture can affect the feed speed of the media usually causing
it to feed more slowly than the baseline media (High Gloss Paper). This will cause the height/length
of your cut to be shorter. If you find that your cut height/length is longer or shorter than the height
specified in the PTCreate software, you may need to increase or decrease the stretch factor.
Increasing this value with create a longer cut. Decreasing it will create a shorter cut.
Adjusting Knife Pressure over time.
Eventually, the knife blade will begin to wear and require more cut pressure to cut at the same
depth as when it was brand new and sharper. Therefore, you may need to add cut pressure when
cutting any media even the High Gloss Paper.
To determine if cut pressure should be increased or decreased, follow these steps.
1. Print and cut 1 copy and then attempt to peel the label from the liner.
2. Check for tear. If the label tears when you remove it, you will need to increase the cut
pressure. Increase pressure in small increments to avoid over compensating and cutting
through the liner.
3. Check the liner. Once you peel up the label, check the liner. If it has been cut through,
decrease pressure.
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4. Continue increasing or decreasing pressure until the label no longer tears when
removed or the liner is not cut through.
Note about Magnetic Media. The recommended starting knife pressure for the magnetic media is 22. This
media is not meant to be cut all the way through because there is no liner. Instead, this knife pressure
setting is meant to score the magnetic media so that it can be removed by hand after printing. In some
cases, it may be necessary to tear the outer excess material from the intended shape.
If you do cut all the way through this media, it can damage the wear strip, break the knife tip or cause media
jams.

3B Using the Cost Estimator
The cost estimator is found under the queue section on the first tab of the PrintHub. The last five
job costs are stored in the list. Each job will show the cost per label based on the cost per cartridge
entered below the list. Enter the actual cost of the cartridge you paid. Prints remaining on the
currently installed cartridge and total prints on new cartridge are both displayed.

To see a printable/savable report click on the document icon next to the job you want to see. A
report will display the information. You can print or save the report from this screen. You can also
change the currency using the drop down, change the job name or adjust the cost from this screen.
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3C Set the Gap Sensor Mode (Pre Die-Cut Labels Only)
The stock sensor mode refers to the method the Printer will use to detect the print starting position
for each label. To adjust the stock sensor mode, open the PrintHub. In most cases you will NOT need
to change this setting. By default, it is set to sense standard Pre die-cut labels. It is only necessary to
change this setting if you are using clear labels or any label with a black sensing mark on the back.
When you install Digital Die-Cutting Label Stock this setting will automatically be set for you.
1. Connect the Printer via USB and turn on the power. The Stock Sensor Mode setting is stored
in the Printer's internal memory so you will not be able to access it unless the Printer is
turned on and properly communicating with the computer.
2. Go to Start - Programs - Primera Technology - Primera PrintHub.
3. Click on the Label Feed (3rd tab from left).
4. Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the
stock you intend to install.
5. Load the label stock after you have set the sensor mode
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There are three sensor modes:
Die-Cut (Default). If you are using standard die-cut labels that look similar to the graphic, use this
setting regardless of the size of the label. Also, use this setting for Through-hole label material
where a hole is punched through each label or a notch is cut in the side.
Reflective. Use Reflective for label material where a black pre-printed line (black mark) on the back
of the label stock indicates the break between labels. Black marks are required on clear label stock
rolls, or label where the label waste matrix (waste) is left on the liner. Black marks can also be used
for irregular shaped labels, circles larger than 4 inches or on any stock where the print starting
position cannot be sensed using the label itself.
Continuous. (Sensor off) If you have continuous stock with no die-cut, reflective mark or holes, set
the sensor type to Continuous. This will turn off the stock sensor. In this mode there is no way to set
the print starting position. The Printer will simply start printing the first label and print each
subsequent label immediately after that previous one. To produce a gap between prints simply add
the desired amount of white space to the end of the label being printed. The Printer will
automatically switch to this setting when Digital Die Cutting Label Stock is installed.
Important Note: You must also set the Stock Sensor Position (Section 2G)
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3D Set the Label Feed / Cut Mode
Use the Present/Cut Mode to adjust how the Printer presents labels after they are printed or
if/when they are cut after printing. To adjust the Present/Cut Mode, open the PrintHub program.
1. Connect the Printer via USB and turn on the power. The Output/Cut Mode Setting is stored
on the printer main board so you will not be able to access it unless the Printer is turned on
and properly communicating with the computer.
2. Go to Start - Programs - Primera Technology - Primera PrintHub.
3. Click on the Label Feed Tab.
4. Click on the Output/Cut Mode button.
Cutter Options

Cut after button press. This setting will cut after you press the Load/Feed button on the Printer.
This can be used after one label or an entire job. This feature is useful if you will not be present at
the end of the print to catch the cut label.
Cut after label count. This option will cut after the number of labels specified in the toggle box that
appears when this option is selected. This is useful if you have front/back labels or sets of labels.
Cut after no activity. This setting will cut at the end of a print job if the Printer does not receive
another print job within one second of the last print job in the queue. You can use this feature to
cut at the end of multi-copy job, multi-page job or multiple individual jobs in the queue.
Cut every label. This setting will cut after every label.
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3E Adjusting Print Alignment
If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11
inch paper you probably are not familiar with an essential part of a label printing - Print Alignment.
Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit
printing to the edge of the sheet. This is to avoid any need for alignment.
The LX610 senses the beginning of the label with an optical sensor and is capable of printing to top,
bottom, left and right edge. Because of this it is necessary to align the Printer to work with specific
types of label stock.
The LX610 comes factory calibrated to print exactly to the edge of Primera label stock. However,
due to variations in the left margins and other variables it may be necessary to fine tune these
settings at the beginning of each roll. This is especially true for other non-Primera brand label stock.
Adjust print alignment using the PrintHub. Go to the Print Alignment Tab (second tab).

Click More Settings to adjust the edge scan. By default the Printer
will scan for the edge of the media to determine the horizontal
start position. Some media may not produce consistent scan
result. In those cases you can uncheck the Scan Edges box. By
default, the Printer will scan for the horizontal start position ever 4
labels. Increase/Decrease the Edge scan skip count to change the
frequency of the scan.
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Click on Test Alignment to print the alignment shown to the right.
Look at the print to determine how much white space is visible on
the edges. The black lines should print right on the leading edge
and left edge. In this example the Top of Form needs
approximately - 10.
1. Left Margin Offset. This value moves the printed label left
or right. Add to the current value to move the printed label
to the right. Subtract from the current value to move the
printed label to the left.
Adjust

2. Top of Form (TOF). This value moves the print start position
Top of Form -10
up or down on the label. Add to the current value to move
the printed label down or toward the Printer. Subtract from the current value to move the
printed label up or away from the Printer. The value is automatically saved as soon as you
set it. You may have to make several adjustments to one or more of these values. After each
adjustment you can click the Test Alignment button to print a small test pattern on the label.
This will help you find the proper alignment value.
3. Tear off/Cut Position. This value adjusts the position of the last label printed after it has

been presented. This only applies if the output mode is set to "Present the label." Add to the
current value to move the tear point closer to the Printer. Subtract from the current value to
move the tear point away from the Printer. The value is automatically saved as soon as you
set it.
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3F PrintHub Settings
General application settings that apply to the software and all printers can be found by clicking the
blue “Settings” button in the lower left. Printer specific settings can be found on the “Printer
Settings” Tab. See next section.
Language. Typically, the language is set to match the language setting in the operating system.
However, you can override currency settings on the Language Tab.
Automatic Updates. Automatic Updates will update PrintHub, the printer driver and the printer
firmware. Every 7 days you will be prompted to update the software if there are any newer
versions. You can choose to increase or decrease that automate check. You can also perform a
check for updates immediately by clicking the “Check for Updates” button. Finally, if you would like
to receive beta software check the “Check for Beta updates” box

Printing Preferences. You can choose to close PrintHub after printing completes by checking the
“Close this application after printing completes” box. PrintHub automatically opens whenever you
send a print job to the Printer. If you do not want PrintHub to open in front of other programs, you
can check the “Launch minimized during print” option.
Support. Click the “Generate Support Report” button to generate a zip file on your desktop
containing all recent log files. Send this to tech support so they can help solve any printing
problems.
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Advanced. Check the “Generate Printer Status XML” box to create an XML at
"C:\ProgramData\PTI\PrintHub\PrinterStatus.xml".
Software developers can use this file to display status information such as error messages and ink
levels in 3rd party applications.
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3G PrintHub Printer Settings
Printer settings can be found in Primera Print Hub on the Printer Settings Tab for the LX610.

Information. This section displays all current driver, software and firmware versions.
Advanced Setting Button. Click the Advanced Settings button to view the following settings.
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General Settings

3G1. Multiple Printer Support.
You can install multiple printers to the same computer and use them simultaneously. To do so you
will need to change the USB serial number identifier of one of the two printers, two of three
printers, three of four printers etc. To change serial numbers:
1. Connect each new Printer one at a time. The current USB Serial Number will be displayed.
2. Click Generate. It will find the next available USB Serial Number based on the currently
connected printers. For the first one it should set it to 2 and for the next printer 3 and so on.
3. Click Set. You will hear the Printer reset and the settings window will turn gray. After it
resets you will be able to see the settings window again. Keep the Printer connected.
4. Now you can connect the next Printer. Windows will automatically install a new driver for
that new Printer and name it Color Label 610 (Copy 1). You can rename it later by editing the
printer properties in the Windows printer list.
5. You will now see a second printer appear in the left column – Color Label 610 (Copy 1). Click
on it to display information about this Printer. If this is the last Printer, you will connect you
are done. If you wish to connect additional printers follow through steps 2-4.
Restore Factory Defaults. This will set all Print alignment and other calibration settings back to
factory defaults.
Cartridge Settings. Here you can adjust the frequency of certain maintenance operations. Increasing
the value of “Seconds between Maintenance Spits” will decrease ink usage but could also cause
poor quality printing.
Increasing or Pages between Maintenance Wipes will speed up printing but could also cause poor
quality printing.
Check the Suppress Alignment message to prevent the window from appearing which prompts you
to align the cartridge every time a new cartridge is installed. Skipping the alignment is faster but can
result in poor print quality.
Stock Feed Settings.
Adjust these settings only if directed to do so by Tech Support.
Calibrate the paper sensor if you are receiving TOF errors. The calibration process will prompt you
to remove all paper/stock from the Printer before calibrating.
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Section 4 Printing and Cutting with PTCreate on PC and Mac.
PTCreate is everything you will need to layout your prints and cuts for your LX610. Every object that
you place in your layout, can be set to print only, cut only or Print and Cut. There are two different
versions. The Standard version comes with the Printer. The Professional version can be purchased.
After a 30-day trial the Professional version requires an activation code. During the trial you can use
the program but you are not able to save files or send cut files to the Printer.
Mac Note: Only the Pro version is available for Mac users. The following screen captures are from
the PC software. However, all Pro version features are the same on Mac and PC. Locations and
functions are the same on Mac and PC.
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4A Overview (Standard version vs Pro version)

All features are available in both Pro and Standard unless noted otherwise.

1. Layers. (Pro Only) Layers allows you to see and manipulate layers of imported SVG files
or elements added within PTCreate. SVG files can be created in programs like Adobe
Illustrator.
2. Import. Standard Version import allows you to insert flat files like JPG, BMP or PNG
which can be a graphic you would like to print. Pro Version Import allows you to import
flat files and Vector files like AI, EPS and SVG which can be a graphic you would like to
print, a cut file or both in the same file.
Trace (Pro Only) allows you to create a cut file be tracing a JPG, BMP or TIF or other flat
file that you have imported. This is a great option for creating complex cut files without
needing another expensive and complex design program.
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3. Advanced Design Tools. (Pro Only) Advanced design tools such as Gradient, Eye
Dropper, Eraser, Draw Tool and the Shape Node Tool allow you to create your own
design in PTCreate.
4. Text Tool.
You can create simple text to add to your PTCreate designs. View this
article and video for more information.
5. Document, Position and Size, Fill and Stroke, Style, Text. These tabs all manipulate
existing objects on the page. Document controls the artboard or page size. Position and
size allow you to precisely move objects on the page. Fill and stroke allows you to change
the color of lines. Style allows you to change whether a particular object should be cut,
printed or both. Text allows you the change font and size of text objects.

a. Document. Use this tab to adjust the page size after it has already been setup.
Sometimes you may need to increase the height the page to accommodate a
bleed or multiple rows.
b. Position and Size. You will use this tab to move both the cut line and the image
on the page. It is much easier than trying to drag and drop images manually.
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c. Fill and Stroke. Use this to change the line style of the cut. For the most part you
should leave these settings at their defaults. If you are having trouble seeing your
cut line, you can change the color of it here.
d. Style. Here you can designate whether any object should be Print, Cut or both.
By default all images imported using the import icon will be set to Print. Also, all
objects drawn using the rectangle or circle tool will be set to Cut. However, this
tab will allow you to adjust this if necessary.
e. Text. The text tab allows you to adjust the font, size and other properties of text.
Text can be added using the Text tool from the left side tool bar.
6. Library. The library contains some preset
shapes that you can apply to your
document as cut objects or print
objects.
7. Page Layout. This area shows your
actual image. You can move objects
here by clicking and dragging. You
can also see where the cut will be
made in relation to your print. In the
example above the cut line is
highlighted red and inset (overbled)
slightly so there will unprinted area on the
label

52

4B PTCreate Software Activation
You will need to activate the Professional version of your PTCreate software.
If you purchase the Pro Version, you will be sent an activation code in your purchase confirmation.
To Activate follow the activation prompt that appears when you open the software or go to the
Help Menu - Activate

An activation windows will appear. Enter the 30-digit activation with the dashes included. Click OK.

The software is now activated on this computer.
Important Note: Activation requires internet
access!
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4C Software Deactivation
To move the activation to another computer you will need first remove the activation from this
computer.
To remove activation, go the Help Menu – Deactivate…

A confirmation prompt will appear.

Important Note: Deactivation requires internet access!
If you are unable to deactivate because of a computer crash, please contact tech support to receive
another activation code. If you have the Pro version, please have your order number ready to
speed up the process.
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4D Tutorial How to setup a Print and Cut in PTCreate Standard
This tutorial will walk you through the basic steps to print and cut a label.

4D.1 Choosing a Label Size (Page Layout)
After you activate your software you will be prompted to open or create a new project.
1. Choose New Project…

2. Set your page size. Since all die cutting media is 4.25” wide the standard maximum width is
automatically set to 4.25. In this example we have set the size to 4.25 x 3 to accommodate
approximately a 4” x 3” label.

Tip! Set your page larger than the
label size to be cut. This will allow
you to create a bleed around the
label so that you always cut inside
your print and get perfect cut every
time.
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3. To set the page height or width to a custom size type the size in the W: and H: boxes or
toggle the size up or down with the arrows.

4D.2 Import a flat Image (JPG, BMP, PNG, TIF, GIF)
PTCreate Standard allows you to import flat files for printing only. You can import the following
image formats: JPG, BMP, PNG, TIF, GIF.
Important Note: Primera recommends imported images are at least 300 DPI. The software is
optimized for this size. Larger DPI images can be manually resized. Smaller DPI images will not
utilize the maximum quality of the Printer and may appear pixelated. Images downloaded from
websites are typically made to display only onscreen load quickly so they are typically only 72 DPI.
To import an image for printing follow these steps.
1. Go to the File Menu or shortcut bar, choose Import.
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2. Browse to the file you would like to use and choose Open.

3. The file will appear on your page layout.
4. You can manually move it on your page or increase the size. However, a better option is to
use the Position and Size window. Set the size to match the size of the page layout. In this
case set the width to 3.25” and check the Keep Proportions box.
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5. Center the image horizontally and vertically to the Page.

4D.3 Add a Cut file
In PTCreate Standard you can either draw a box in the approximate location of the cut file or use
one of the preset size from the library. If you have a rectangular label or you would like to add a
corner radius to your cut it is preferable to draw the cut line. Corner radius make it easier to
remove your label from the liner. In this example we will draw the cut line.
1. RIGHT CLICK on the

rectangle icon and choose
Rounded Rectangle.
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2. Before you start to draw the cut line, adjust the corner radius. You will not be able to

change this after you draw your cut line. The corner radius is the amount of curve around
the corners. .125 in (1/8 Inch) is the standard corner radius.

3. Draw the cut line by hovering your mouse over the top left corner of your design. When you

are ready to start, left click and hold to start the rounded rectangle box. Keep holding the
left mouse button and move to the lower right corner of your design. Let go of the mouse
button when your box is the approximate size you would like it. We will adjust the exact size
and position in the next step but to maintain a proper corner radius it is important to get as
close as possible in this step.
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4. Once the cut line is in place you can adjust its size and positon. Whatever size you choose

will be the exact size of final cut label. A typical overbleed is 1/16”. This will ensure that the
cut is completely within the printed label every time so you have no white space around the
edges.
a. First select the cut line using the arrow tool. TIP: If you are having trouble selecting
the object, first select any object and then press the TAB key to move the selection
from object to object.
b. Then change the size. Adjust the size to 1/16 (.0625”) less than the height and width
of the print. In this example the cut file would be 3.937 x 2.937. You may have to
uncheck the Keep Proportions box.
c. Finally adjust the position by centering horizontal and vertical alignment to Page.
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4D.4 Print.
To print go to the File Menu and choose Print or click the Print Icon on the shortcut bar. The print
dialog will appear. Make sure Print+Cut is selected. Click the Properties button to access the printer
settings such as Print Quality, Saturation and Color Matching. For a full explanation of printer driver
settings see section 5E

Note: Before printing we recommend
clicking the print Preview Button
described in section 4H
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4E: Tutorial: How to Setup a Print and Cut using PTCreate Pro – Vector File Cut
If you have a designer that is able to use an advanced program like Adobe Illustrator or Corel Draw,
you can save your print file and cut file together as a multi-layer vector file in AI, EPS, or SVG format.
You can then import them into PTCreate and designate which layer will be the cut and which will be
the print. This will allow you to create complex cuts in exactly the right shape and exactly the right
position. This method is the best way to get the highest quality print and cut. While tracing the
image using the steps in the previous section will allow you to create the same shapes, you can save
time and create a smoother cut file using this
method.
Important Note: Before you start with PTCreate, your
designer should create the print and cut line together
and save them as two separate layers in the same
file. You’ll be able to see these layers when you
import the file into PTCreate.
Cut Layer

Print Layer

4E.1 Choosing a Label Size (Page Layout)
After you activate your software you will be prompted to open or create a new project.
1. Choose New Project…

2. Set your page size. Since all die cutting media is 4.25” wide the standard maximum width is
automatically set to 4.25. In this example we have set the size to 4.25 x 6 to accommodate
approximately a 4” x 6” label.
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Tip! Set your page larger than the
label size to be cut. This will allow
you to create a bleed around the
label so that you always cut inside
your print and get perfect cut every
time.

3. To set the page height or width to a custom size type the size in the W: and H: boxes or
toggle the size up or down with the arrows.

4E.2 Import a Vector Image (PDF, AI, EPS, SVG)
PTCreate Pro allows you to import vector files for printing and cutting. You can import the following
vector image formats: PDF, AI, EPS, SVG
To import an image for printing follow these steps.
6. Go to the File Menu or shortcut bar, choose Import.
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7. Browse to the file you would like to use and choose Open.
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8. The file will appear on your page layout. You can manually move it on your page or increase
the size. However, a better option is to use the Position and Size window. Set the size to
match the size of the page layout. In this case center the image to the page.
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4E.3 Working with Layers in an Imported Vector File
Once you have imported the vector file you view the layers in the layers window.
The cut file must separated from the design at the top level. It cannot be buried
under other layers that will be printed. In this example the cut line layer is setup
in Illustrator as an Outline instead of a Fill. Either will work but Outline is
preferable.
Outline
9. To view the sublayers and find the cut line click on the arrow to open up the group.

Click Arrow to open layer groups

Note: Before printing we recommend clicking the print
Preview Button described in section 4H
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10. Once you find the cut line, select that layer and click the style tab above.
A. Choose Cut Only!
B. Set Style to Blackout.
11. Now select the Print layer, click on the stye tab above and choose Print Only!

Layer to be Cut

Layer to be Printed

12. To print go to the File Menu and choose Print or click the Print Icon on the shortcut bar. The
print dialog will appear. Make sure Print+Cut is selected. Click the Properties button to
access the printer settings such as Print Quality, Saturation and Color Matching. For a full
explanation of printer driver settings see section 5F.
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13. If you do not choose the Blackout option described in step 10 and 11 you may end up with a
double cut that will cut through the liner/backing paper of your label. Check for this in the
preview.

Double Cut Preview

Good Cut Preview
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4F Tutorial: How to Setup a Print and Cut using PTCreate Pro – Contour Cut
This tutorial will walk you through the basic steps to print and cut a label using the trace image /
contour cut feature found in the Professional version of PTCreate.

4F.1 Choosing a Label Size (Page Layout)
After you activate your software you will be prompted to open or create a new project.
1. Choose New Project…

2. Set your page size. Since all die cutting media is 4.25” wide the standard maximum width is
automatically set to 4.25. In this example we have set the size to 4.25 x 4.25 to
accommodate approximately a 4” x 4” label.

Tip! Set your page larger than the
label size to be cut. This will allow
you to create a bleed around the
label so that you always cut inside
your print and get perfect cut every
time.
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3. To set the page height or width to a custom size type the size in the W: and H: boxes or
toggle the size up or down with the arrows.

4F.2 Import an Image.
PTCreate Pro allows you to import flat files and vector files. You can import the following image
formats: AI, EPS, PDF, SVG, JPG, BMP, PNG, TIF, GIF.
Important Note: Primera recommends imported images are at least 300 DPI. The software is
optimized for this size. Larger DPI images can be manually resized. Smaller DPI images will not
utilize the maximum quality of the Printer and may appear pixelated. Images downloaded from
websites are typically made to display only onscreen load quickly so they are typically only 72 DPI.
To import an image for printing follow these steps.
4. Go to the File Menu or shortcut bar, choose Import.
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5. Browse to the file you would like to use and choose Open.

6. The file will appear on your page layout.
7. You can manually move it on your page or increase the size. However, a better option is to

use the Position and Size window. Set the size to match the size of the page layout. In this
case set the width to 4” and check the Keep Proportions box.
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8. Center the image horizontally and vertically to the Page.

4F.3 Trace Image and create Cut Line
Tracing the images requires a flat file such as BMP, GIF, JPG or PNG.
9. Select the image object that
you just imported. This is very
important. You’ll know it is
selected when the bounding
box appears around the image.
Now click on the Trace Icon.
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10. There are many options available in the Trace Image window. However, the most important
option is the Contrast. You should adjust the contrast until the preview shows a single green
highlighted image in the shape you would like to cut.

11. Click Update Preview to show the cut lines and the number of points/nodes in your cut file
(if you check Show Nodes). These nodes are the points on your image to which the knife will
travel to cut the label. Don’t worry if your cut line isn’t exactly in the right position or size.
We’ll adjust that later. At this point you are just looking for smooth lines that represent the
correct shape.
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12. Note the difference in the preview when you increase and decrease the contrast.

Contrast to High: If contrast is too high you will lose the shape detection
and end up with a rectangle cut.

Contrast to Low: If contrast is too low you will end up with extra cut lines
outside of the main cut and potentially the wrong shape. In this example
the cut line is tracing the wrong part of the image.
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13. Click OK when you are happy with the shape of your cut line. The cut line will appear on top
of your image as a red outline. You’ll see a trace layer appear in the layer window.
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4F.4 Offset a Cut Path
14. Now you’ll need to offset the cut line inside your image so that you’ll have a bleed. With the
cut line selected go to the Path Menu and select Offset.

15. On the Path Offset Window, check the Inset Offset box and adjust the amount of offset. For

this image we chose 0.040 inches. You’ll see a preview of the new position of the cut line in
black.
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16. Click OK to change the Offset. The new cut line will appear.

Note: Before printing we recommend
clicking the print Preview Button
described in section 4H

17. To print go to the File Menu and choose Print or click the Print Icon on the shortcut bar. The
print dialog will appear. Make sure Print+Cut is selected. Click the Properties button to
access the printer settings such as Print Quality, Saturation and Color Matching. For a full
explanation of printer driver settings see section 5F.
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4G Setup multiple identical cuts (Duplicate and Array)
If you intend to print and cut a smaller label such a 2” circle you may want to duplicate that image
and cut line across the page so that you don’t waste material. No matter what your label size is
your page size for die cutting is always 4.25”. It makes sense to fill up that page with as many labels
across as you can. Follow these steps to Duplicate images and cut across the page.
1. Create your page size. In this example we chose 4.25” x 4.25”. You can choose a custom size

to fit your labels. In this case we wanted to choose a height that was able to accommodate 2
rows and two columns of 2.125 x 2.125 cut to 2” x 2”.

2. Import your image using the import Icon.
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3. Set the Size and Position. In this example we are setting the size to 2.125 x 2.125. Center the

image horizontally and vertically.

4. Create your cut line using the shape tool on the left size tool bar. Right click on the rectangle
icon and choose the circle tool.

5. Draw the circle close to the size of the images. You
don’t have to be accurate on this step since we will
be changing the size and position in the next step.
6. Set the size to correspond to the actual cut label
size you would like. In this case we set the size to
2” x 2 so that we have a standard 1/16” bleed
around the label. Uncheck the Keep Proportions
box. This will make sure that no labels have any
white unprinted areas around the edges.
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7. Center the cut line horizontally to the page

8. Using the arrow tool select both image and the cut line by drawing a box around them.
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9. Group them together by going to the Object Menu – Group. This will ensure that cut says

with the image and in the correct relative location while we move and duplicate the image in
the next steps.

10. Align the group image and cut line to the upper left corner.
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11. Now go to the Object Menu and click Duplicate. Make sure the image and cut line are still
selected otherwise the Duplicate item will not be available.
12. Set the number of rows and columns.
13. Set the gap between the rows and columns.

In this case we are setting the gaps to zero.
We already created a bleed so the cuts will
not intersect or be too close to each other
with zero gap between prints.
14. To print go to the File Menu and choose
Print or click the Print Icon on the shortcut
bar. The print dialog will appear. Make sure
Print+Cut is selected. Click the Properties
button to access the printer settings such as
Print Quality, Saturation and Color
Matching. For a full explanation of printer
driver settings see section 5F.
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4H Print Preview
Before you print you can click the Preview button to verify what objects will cut and what objects
will print. Check either Show Cut Lines or Show Printable to see what will print or cut.
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4I Vector File Specifications for Designer
When importing files using the methods described in section 4E please make sure the imported file follows
the specifications below:

1. Place the design on a top layer. Place the cut line on another top layer at the same level as the
design. Do not bury the cutline inside the design.
2. The cutline should be a compound path set as outline. Set the color to any color that stands out
against the design.
3. Position the cut line exactly where you want it relative to the design. The cut line should be the size
of the final label. The minimum over bleed should be 0.040”.
4. The workspace should match the full bleed of the design to be printed.
5. Convert fonts to vector graphics by outlining them. (In Illustrator, select the text - go to the Type
Menu - Choose Create Outlines.)
6. Save the design as a vector file in this order of preference. 1. SVG File 2. AI File 3. PDF File.

4

3

1

2
5

84

Section 5: Printing only to Pre Die-Cut labels
If you don’t need to cut custom shapes, the LX610 is an extremely capable Pre Die-Cut Label printer.
While PTCreate can print only to the LX610 other dedicated printing programs offer some
advantages.

5A Using BarTender for Pre Die-Cut Printing
Primera Special Edition BarTender UltraLite is included with the printer. You can download it at
the link below. Use the code below when prompted after installation.
Download: https://portal.seagullscientific.com/downloads/bartender
Code: Z3T0-7ZJY-JFD1-3J9P
When you open BarTender you will be given the choice to select an existing label or create a new
one using a wizard. Use the following instructions as a guide through the wizard setup process.
1. Choose "Start a new BarTender document..."
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2. Select "Blank Template". Click "Next".

3. Select "Color Label 610". Click "Next".
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4. Select "Specify Custom Settings". Click "Next".

5. Set the page size, width and height to match labels installed in the Printer. Click "Next".
Important: Measure the label stock if you are unsure about the size.
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6. Select your label shape. This is typically "Rounded Rectangle" for standard labels from
Primera. Click Next.

7. Set all of the margins to zero. (You can adjusted the left margin and Top of Form in the Label
Alignment Section). Click Next.
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8. Set Rows and Columns to 1 for a standard label. Click Next.

9. Set Template Size to be the same as the label size. Click Next.
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10. Check the "Picture" box to add a background photo or graphic to your label. Click "Next". If
you click "Finish", the remaining default wizard options will be set and no picture will be
added.

11. Select "Embedded Picture". Click the "File" Button to browse to the location of your
photo/graphic file. Set the Size Method to "Stretch". Note the preview to the right. Click
"Next" if you are satisfied with the layout of the photo or graphic. Otherwise you may try
one of the other Size Methods in the drop down menu.
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12. Review the label setup summary. If it is correct, click "Finish". Your blank label or label with
background will be displayed.

You can edit any of these initial settings by going to the File Menu and selecting "Page
Setup". Basic and advanced settings are available on the various tabs.
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5B Using BarTender to add cut lines
Any Shape can be converted to a cutline that your LX610 printer can cut. You must use BarTender version
2021 Ultralite, Professional, or Enterprise.

1. Click the shape icon on the tool bar.

2. Drag the shape around the object(s) you want to cut. Adjust the size by dragging or set the size
exactly by clicking properties.

3. Adjust the Width, Height, Corner Type and Corner Size (Radius). A typical corner radius is .125”.
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4. To convert it to a cut line click on the name of the object. By default, it will be named "Box 1" or
"Ellipse 1" (for circles). You can also change the name to anything, but it will always be listed first in
the properties window.
5. Now check the “Cut path” box. You will see the box outline convert to a dashed line.

6. Repeat the procedure for all the objects you want cut on your page.
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5C Add Text, Barcodes and Graphics to a BarTender Label
Once you have created your label size you will be able to add text, a barcode and/or graphics. This
can be done using one of the buttons on the button bar at the top of the screen.
Add Graphic. Click the Image button.
Now click anywhere on your label.
An Image icon will appear. Doubleclick it to open up image settings
and browse to the image/graphic
that you would like to insert.

Add Text. Click the Text button. Now
click anywhere on your label.
"Sample Text" will appear. Edit the
text on screen or double click it to
open up text settings to change font,
size and other settings.

Add Barcode. Click the Barcode
button. Now click anywhere on your
label. A barcode settings window
will appear. Here you can choose
any type of barcode and enter the
value.

Page Setup. Click the Page Setup
button to change your label size,
adjust corner radius or change the
shape.

Tip! Double-click any object to open settings for that object.
Tip! Go to the Help menu to access the BarTender Manual and Tutorials.
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5D Printing from Other Programs
Since this Printer uses a standard Windows printer driver you can print from any application you
would like. There are just a few things to remember that will make it much easier.
1. Set the Page/Label Size in the Driver. BarTender automatically prompts you for the size of
the label that you are using. When printing from any other program you must do this
manually. Before you print, simply set the custom page size just as you would set print
quality in the printing preferences. In the example below the label size is 4" x 3" so the
custom page size is set to 400 x 4300 (displayed in .01 inch units).

2. Check the image or document size. The image size or document size set in Illustrator should
match to the Page/Label Size set in the driver. If you have set your page size to 4" x 4" but
your image is actually 5" x 3" the printer driver will automatically shrink your image to fit
inside the 4" x 4" label. The result is that the actual printed label is 4" x 2.4". Avoid this by
setting your document size or image size to match the label size.
3. Choose the right printing program. There are many different applications that are capable of
printing to the LX610. However, there are only a few that are ideal printing applications. For
example, Adobe Illustrator is an excellent design program but is not always the best printing
program. It can be difficult to find the printing preferences or to know the exact size of the
art board. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi
JPG and print from BarTender.
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5E Creating a Full Bleed Print
To create a label that completely fills the space with no white margins, adjust these settings in the
status monitor and printing application (BarTender). This is only necessary if you are printing to PreDie Cut Label stock. If you are printing and cutting using die cutting media, you can adjust the
position of the cut line to accomplish this.
Page Size. Increase the page size width by .03 inches (1mm). Increase the height by .03 inches
(1mm). If you are using BarTender, simply change the size under the File Menu - Page Setup. If you
are using other graphics programs you will need to change the page size in the application and in
the printer driver preferences.

Left Margin Offset. You must decrease the left margin offset to center the over bleed on the label. If
you over bleed by .03" you will need to decrease the Left Margin Offset by 0.4mm. This will center
the page size increase so there is a .03 inch over bleed on both left and right sides. Some additional
adjustment may be necessary if the label was not perfectly aligned to begin with. See Section 4E.
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TOF. Increase the Top of Form by 0.4mm. This will cause the Printer to start printing before the
label and ensure a fully printed label. Some additional adjustment may be necessary if the label was
not perfectly aligned to begin with. See Section 4E.

Note: It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over
bleeding too much will cause the Printer to skip labels. This is because the Printer stops printing too
late to sense the next label.
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5F Printer Driver Settings
Once the printer driver has been successfully installed, you will need to setup the driver with the
appropriate print options. Refer to the following steps to change or verify your default printer driver
preferences. These settings will apply to all new designs created in BarTender or other programs
after the preferences were changed. Existing labels saved in BarTender will not be affected since the
preferences are saved with the label. To change these preferences, you will have to change printer
preferences through BarTender. (File Menu - Printer Settings)
Click the Start button, search for "Printers". Select Printers and Scanners. Select the Color Label 610.
Choose Manage. Select Printing preferences.
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Note on PC Settings:
Most applications allow you to change these same printer driver options from their "Print" and/or
"Printer Setup" screens. Some applications such as BarTender save your settings with the label,
others use settings only for the current print job just sent to the Printer.
Paper Size
If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a
program other than BarTender you will need to set this to the dimensions of your label. Keep in
mind that the dimensions are always relative to the width and height of the actual label in the
Printer. Orientation of an image on the label should not change this setting. See Section 2A for
minimum and maximum label sizes.
Orientation
There are two settings for orientation, Portrait and Landscape. If your text and graphics print left to
right or as shown on the screen, select portrait. If you wish your printing to rotate 90 degrees from
what you see on the screen so it is printing horizontally, select landscape as your orientation.
Remember, this does not change the width and height Paper Size. It is only a tool for viewing a label
upright on screen that will be printed sideways on the Printer.
Print Quality
There are 4 levels of print quality in the driver. The lower the quality, the faster the print. Quality 1
provides the fastest print available while Quality 4 provides the best quality. It is recommended that
you experiment with the different levels when designing your label to find a good balance between
print quality and print speed. Quality 2 is the default.
Color Matching
There are several options available depending on which cartridge is installed (Pigment or Dye). The
options will update automatically depending on which cartridge is installed.
Vivid Graphics mode is best used for graphical images where accurate color reproduction is not as
essential. Images printed in this mode will look more vibrant because more ink is being used to
produce them. However, printing images of people may produce skin tones that have a reddish tint.
Vivid Photos mode is best used for photographic images where accurate color reproduction is very
essential. Images printed in this mode will look lighter than those printed in Vivid Graphics mode.
Skin tones especially will look more natural in this mode.
ICC Gloss Paper, ICC Gloss Polyester and ICC Matte Bopp are all ICC calibrated color matching
options. Select the setting that corresponds to your installed Primera media of the same type to
produce ICC color matched prints. Note: For best results we recommend ICC monitor calibration.
-NONE- will use no color matching.
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Ink Saturation
This option controls the amount of ink used when printing an image. The default setting is 100%,
which will provide the most accurate color matching. If the ink is not drying fast enough or
"bleeding", you can decrease the Ink Saturation to lessen the amount of ink that is applied to the
label.
Rotate 180 Degrees
Set this setting to Yes to print with the labels right side up as they exit the Printer.
Enable Bi-di
Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge change. Set to
"No" for better quality print (in some cases).
Launch PrintHub
This setting will open the Primera PrintHub application.
Details
Select this setting to see current firmware and driver version information and other printer settings.

100

Section 6: Printing from a Mac
6A Print Utility Settings (LX610 Config Utility)
The LX610 Config Utility is used to interact with the Printer for gathering ink levels,
maintenance, alignment, and several other functions.
To Find LX610 Config Utility:
The LX610 Config Utility automatically installs with your printer driver and can be accessed
through the Printer & Scanners in Mac under Apple Icon – System Preferences.
1. Connect the Printer via USB and turn on the power. The LX610 Config Utility accesses
most of the information it uses from the Printer itself so the Printer must be turned on
and communicating for the program to open.

2. Go to the Apple Icon – System Preferences - Printers and Scanners, select the PTI
Color_Label_610, click on, Options & Supplies, and Open Printer Utility. Or you may
simply print to the Printer and the Utility will open.
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3. The LX610 Config Utility has 4 tabs that are arranged on the top of the window. Each
tab opens a screen that has various similar functions.
-

Status Tab (First Tab). Displays ink levels, print counter and any error messages.

-

Cartridge Tab (Second Tab). Use for aligning the cartridge, cleaning the cartridge, and
changing cartridge.

-

Alignment Tab (Third Tab). Adjusts vertical and horizontal print alignment. Changes
the Stock Sensor Mode, toggles the Output/Cut Mode and XY Cutter Alignment
Settings.

-

Settings Tab (Fourth Tab). Displays printer information including firmware version,
driver version, and software version. Check for updates and set other advanced
settings.

6B Adjusting Print Alignment/Label Offsets (Pre die-cut Stock Only)
If your previous experience with printing is limited to printing letters and cards to 8.5 inch
by 11 inch paper you probably are not familiar with an essential part of label printing – Print
Alignment. Standard printers feed a sheet and start printing based on the start of the sheet.
They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment.
The LX610 senses the beginning of the label with an optical edge. Because of this it is
necessary to align the Printer to work with specific types of label stock.
The LX610 comes from the factory calibrated to print exactly to the edge of Primera label
stock. However, due to variability it may be necessary to fine tune these settings at the
beginning of each roll. This is especially true for other non-Primera brand label stock.
Important Note: Before adjusting alignment settings first print one label at the quality level you
intend for the entire print job. This will ensure the label stock is moving at the same speed
and the stock sensor will sense the gap in the same way.
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Adjust print alignment using the LX610 Config Utility. Click on the Alignment Tab (Third
Tab).

Note: This section only
applies to Pre Die-Cut Stock.
For an explanation of stock
types, please see section 2A.

Three items can be adjusted here:
Top of Form (TOF). This value moves the print start position up or down on the label.
Add to the current value to move the printed label down or toward the Printer. Subtract
from the current value to move the printed label up or away from the Printer. After
adjusting the value click the Set Offsets button to send the value to the Printer.

*

Cutter Offset. This value adjusts the position of the last label printed after it has been
presented for tear off. This only applies if the output mode is set to “Present.” Add to
the current value to move the tear point closer to the Printer. Subtract from the current
value to move the tear point away from the Printer. After adjusting the value click the
Set Offsets button to send the value to the Printer.

*

Left Margin Offset. This value moves the printed label left or right. Add to the
current value to move the printed label to the right. Subtract from the current value to
move the printed label to the left. After adjusting the value, click the Set Offsets button
to send the value to the Printer.

*

You may have to make several adjustments to one or more of these values. After each
adjustment you can click the Test Offsets button to print a small test pattern on the label.
This will help you find the proper alignment value.
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6C Set the Stock Sensor Mode (Pre Die-Cut Stock Only)
The stock sensor mode refers to the method the Printer will use to detect the print starting
position for each label. To access the Stock Sensor Mode, click on the Alignment button,
then select Stock Sensor Mode. In most cases you will not need to change this setting.

Note: This section only
applies to Pre Die-Cut Stock.
For an explanation of stock
types, please see section 2A.

Important Note: Set the Stock Sensor Mode BEFORE loading label stock!
You must also set the Stock Sensor Position (Section 2D) so that the sensor is sensing the
correct point on the label stock.
Die Cut (Default). If you are using standard die-cut labels that look similar to the graphic
use this setting regardless of the size of the label. Also, use this setting for through-hole
label material where a hole is punched through each label or a notch is cut on the side.
Reflective. Use Reflective for label material where a black preprinted line (black mark) on
the back of the label stock indicates the break between labels. Black marks are required on
clear label stock rolls, or labels where the label waste matrix (waste) is left on the liner.
Black marks can also be used for irregular shaped labels, circles larger than 4.6 inches or on
any stock where the print starting position cannot be sensed using the label itself.
Continuous. (Sensor off.) If you have continuous stock with no die-cut, reflective mark or
holes, set the Sensor Type to Continuous. This will turn off the stock sensor. In this mode
there is no way to set the print starting position. The Printer will simply start printing the
first label and print each subsequent label immediately after the previous. To produce a gap
between prints simply add the desired amount of white space to the end of the label being
printed.
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6D Set the Output Mode
Use the Present/Cut Mode to adjust how the Printer presents labels after they are printed
or if/when they are cut after printing. There are different options available which change if
the Cutter is enabled or disabled. If the Cutter is disabled, the label present options will be
available. If the Cutter is enabled the present options are no longer available but cut
options become available.
Cut Options (Check Cutter Enabled):
Cut after no activity. This setting will cut at the end of a print job if the Printer does not
receive another print job within one second of the last print job in the queue. You can use
this feature to cut at the end of multi-copy job, multi-page job or multiple individual jobs in
the queue.
Cut after button press. This setting will cut after you press the Load/Feed button on the
Printer. This can be used after one label or an entire job. This feature is useful if you will not
be present at the end of the print to catch the cut label.
Cut every label. This setting will cut after every label.
Cut after label count. This option will cut after the number of labels specified in the toggle
box that appears when this option is selected. This is useful if you have front/back labels or
sets of labels.

Present Options (Uncheck Cutter Enabled)
Do not present. In this mode the label stock does not move after the last label is printed.
This means that part of the last label printed is still in the Printer. This should be used only if
you have a label rewinder attached.
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Present after no activity. This setting will present (feed all printed labels past the tear off
point) at the end of a print job if the Printer does not receive another print job within one
second of the last print job in the queue. You can use this feature to present at the end of a
multi-copy job, a multi-page job or multiple individual jobs in the queue.

Lamination Mode. Check this box to pause printing after every label so you may apply lamination.
This can only be checked when digital die cutting stock is installed. See Section 2H for more
information or view the knowledgebase article.
Create Loop before printing. Check or uncheck this box to affect inconsistent vertical alignment. If
the box is checked a slack loop will be created before each print to assist with easy
feeding. However, for certain size labels, it may be beneficial to uncheck the box. The best setting
depends on your specific label size so it is recommended to try it both ways.
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6E XY Cutter Offsets (Digital Die-Cut Stock Only)
Cut Offsets, Knife Pressure and Stretch Factor settings can be found in Primera Print Hub on the XY
Cutter Tab.

Cut Offsets. If your cut does not line up with your printed image, you can adjust it using the
Horizontal Offset and Vertical Offset settings. Press the Send HPGL Test Print to help you
determine which direction to move the offsets or refer to the image below.

Knife Pressure affects how deep into the media the knife will cut. Ideally you want to cut deep
enough to cut through the label layer on the top but not so deep that you cut through the backing
paper (liner). When you cut through the backing paper your label will not peel cleaning off the
backing paper. You will also score the wear strip under the cutting knife which can cause the knife
tip to break. You will also need to replace the wear strip more often if you cut too deep.
By default, the cutter is calibrated to work with High Gloss Paper Media. However, other media
types will need more or less cut pressure to cut properly.
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Each roll of media will have a recommended value to add or subtract from the default baseline
values used for Knife Pressure and Knife Stretch Factor. These values are listed below and printed
on a label attached to the inside of the core.

High Gloss Paper
High Gloss BOPP
Magnetic

Knife Pressure
0
4
22

Stretch Factor
0
0
32

Knife Stretch Factor can be increased or decreased to compensate for different feed thicknesses
and textures of media. Thickness and texture can affect the feed speed of the media usually causing
it to feed more slowly than the baseline media (High Gloss Paper). This will cause the height/length
of your cut to be shorter. If you find that your cut height/length is longer or shorter than the height
specified in the PTCreate software, you may need to increase or decrease the stretch factor.
Increasing this value with create a longer cut. Decreasing it will create a shorter cut.
Adjusting Knife Pressure over time.
Eventually, the knife blade will begin to wear and require more cut pressure to cut at the same
depth as when it was brand new and sharper. Therefore, you may need to add cut pressure when
cutting any media even the High Gloss Paper.
To determine if cut pressure needs to be increased or decreased, follow these steps.
1. Print and Cut 1 copy and then attempt to peel the label from the liner.
2. Check for tear. If the label tears when you remove it, you will need to increase the cut
pressure. Increase pressure in small increments to avoid over compensating and cutting
through the liner.
3. Check the liner. Once you peel up the label, check the liner. If it has been cut through,
decrease pressure.
4. Continue increasing or decreasing pressure until the label no longer tears when
removed or the liner is not cut through.
Note about Magnetic Media. The recommended starting knife pressure for the magnetic media is 22. This
media is not meant to be cut all the way through because there is no liner. Instead, this knife pressure
setting is meant to score the magnetic media so that it can be removed by hand after printing. In some
cases, it may be necessary to tear the outer excess material from the intended shape.
If you do cut all the way through this media, it can damage the wear strip, break the knife tip or cause media
jams.
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6F Advanced Settings
These settings allow you to adjust feed speed and do calibrations if recommended by tech support.
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6G Printing from Swift Publisher (Pre Die-cut Stock Only)
Swift Publisher is an inexpensive software that can be used to design/layout and print your labels
if you are using a Primera label printer attached to a Mac. Below is a tutorial on how to setup a
label using Swift Publisher by Belight.
Note: This section only applies to Pre
Die-Cut Stock. For an explanation of
stock types, please see section 2A.

Download a Free Trial Here:
https://www.swiftpublisher.com/

When you open the software for the first time you will be asked to choose a Template. Select
Desktop Publishing – Blank. (Do not choose from the “Labels” category!) Choose either blank
landscape or portrait. Click Choose.
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1. It automatically defaults to 8.5 x 11. We will need to adjust the page size and the margins.

2. Type in the size at the top.

Important Note: The page size is not the same setting as the label size. In many cases you will
choose the same size for both. However, if you change the orientation of the label so you can
see text/graphics upgright on screen but the actual print will be rotated, you may need to choose
the opposite setting for the label size. For example: Page Size = 3x4. Label Size = 4x3. Do not
change the orientation as it will change the page size. Orientation is set automatically depending
on the page size.
3. Next, set all margins to zero. This will allow you to create designs that completely fill the
label.
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4. Add Text, Barcodes, shapes and images to your design.

Add Text

Add Shapes

Add Image

Change Font

Toggle Page Setup
menu visibility
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5. For this example, we will add an image that we created. Click the insert Icon and choose
Image from file….

Note: You can also add images from the Backgrounds menu
included with Swift Publisher. Simply drag them to your template.
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6. Once your image is imported into your template you will need to adjust the size to fill the
entire template (if that is your intention). Adjust the size by clicking the ruler icon in the
Inspector with the image selected. Check the “Fit aspect ration” box and then type in your
size.

Image Selected

7. Now center the image by clicking both the horizontal and vertical centering buttons.
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8. You are now ready to print. Click the Print icon to open the print

dialog box.

9. The default label size is 8.5 x 11. You can see this is not correct by looking at the preview.
Always adjust the Paper Size to match the label stock size installed in the Printer.

10. In this case we can choose a preset size (4x3) to match the label size installed in the Printer.

Choose Manage Custom Sizes…
if your label size is not listed
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11. You can now see the preview is correct, the paper size is set so you are ready to print.

6H Creating a Custom Page Size - Mac
In many programs such as Adobe Illustrator, Photoshop or Acrobat Reader you will need to
choose your label/page size before you print. If the label size you need to use is not already on
the list of available pages sizes you will need to create a new custom size on the print screen of
the program you are using to print.

1. Click the Paper Size drop down menu. Choose Manage Custom Sizes.
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2. Click the + to create a new size.
3. Enter the actual width and height of your label stock.
4. Set all margins to zero.
5. Rename the size the same as the width and height.
Rename

Click “+” to start create a new size

Set Width and Height

Set all Margins to zero

6. Your custom size will now appear at the bottom of the preset size list in this application and
any other application on this Mac.
Note: If you need to overbleed your image to achieve complete
coverage of your label, you would use this process to create a
custom size which is .03” (or less) larger than your actual label
stock. For Example 4.03” x 3.03” for a 4” x 3” label.
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6I Creating a Full Bleed Print – Mac (Pre Die Cut Stock Only)
If you are having trouble making the image cover the entire label, first make sure the image is
printing at least as big as the label size you have selected. Increase the selected page size by .03
inches on the width and .03 inches on the height to create an over bleed.
Note: Make sure under scaling options to select ‘Fit to Page’ in the print dialogue box if printing
from Illustrator.
Left Margin Offset. You must decrease the Left Margin Offset to center the over bleed
on the label. If you over bleed by .03 inches, you will need to decrease the Left Margin
Offset by 4. This will center the page size increase so there is an over bleed on both the
left and right sides.
TOF. Increase the Top of Form by 4. This will cause the Printer to start printing before
the label and ensure a fully printed label.

Note: This section only
applies to Pre Die-Cut Stock.
For an explanation of stock
types, please see section 2A.

Note: It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over
bleeding too much will cause the Printer to skip labels. This is because the Printer stops
printing too late to sense the next label.
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6J Printer Driver Settings
Printer driver settings are accessible on the print window of any application right before
you click print.
Printing from Swift Publisher
Click on the Swift Publisher 5 dropdown menu and choose Printer Features.
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Printing from Preview:
Click on the Preview dropdown menu and choose Printer Features.
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Printing from Adobe Reader
First click on Printer... to access settings. Click on the Layout dropdown menu and choose
Printer Features.

2
1

3
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Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print.
Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is
recommended that you experiment with the different levels when designing your label to
find a good balance between print quality and print speed.
Color Matching

Best for Graphics mode is best used for graphical images where accurate color reproduction
is not as essential. Images printed in this mode will look more vibrant because more ink is
being used to produce them. However, printing images of people may produce skin tones
that have a reddish tint.
Best for Photos mode is best used for photographic images where accurate color
reproduction is very essential. Images printed in this mode will look lighter than those
printed in Photo mode. Skin tones especially will look more natural in this mode.
Note: Exact color matching of the printed labels to the screen may never be possible since
there are factors that affect this out of the drivers control. The surface of the label
reacts with the ink in the cartridge to produce the color. For this reason, when printing
the same image to different types of labels with different surfaces the printed output
can look entirely different.
Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is
100%, which will provide the most accurate color matching. If the ink is not drying fast
enough or is bleeding, you can decrease the Ink Saturation to lessen the amount of ink that
is applied to the label.
Enable Bidi (Bidirectional) Printing

Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge
change. Set to "No" for better quality print (in some cases).
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Section 7: Troubleshooting
7A Solving Pre Die-Cut Print Alignment Problems
Image is Vertically Offset (White space can be seen on the top or bottom of the label) The LX610
decides where to start printing by detecting the start of a die-cut label, detecting a black mark on
the back or detecting a thru-hole that corresponds to the start of the label. The following items can
cause the label sensor to improperly detect the start of a label:
1. TOF Offset. TOF stands for Top of Form and this setting allows you to fine tune the alignment of
your printing on your label stock. This will be factory calibrated. If fine tuning is needed, increase
this setting to move the image down on the label; decrease this setting to move the image up on
the label. The unit of measure is 0.1mm.
2. Nonstandard / Non-translucent Backing Material. Test the unit with approved label stock from
Primera (ask tech support to send a sample). If it prints correctly, your label stock may not be
compatible. The label sensor needs to see the difference between a label and a backing material by
seeing through the label stock for light variations. If it cannot see through the label, problems will
arise. If you must use this type of backing, try label stock that has a black mark on the back to show
where the label begins. You will need to change the Sensor Type setting in the driver preferences to
Reflective if you switch to a label with a black mark on the back.
3. Improper Label Gap Distance. If the gap between labels is too small there will not be enough
time for the gap to be detected. See Label Specifications.
4. Page Size is Bigger than Label Stock Size. If the page size set in the driver is larger than the actual
label stock, ink will be printed on the gaps and the sensor will start looking for a gap too late. This
can cause label skipping or inconsistent print starting points.
5. Portrait / Landscape. If the Portrait / Landscape setting does not correspond to the label stock
installed this will also cause the Printer to print over the gap and onto the next label. Make sure this
is set correctly.
6. Sensor Position. Circular, nonstandard label shapes or multiple labels across will require precise
adjustment of the label sensor. If you are using circular or other non rectangular die-cut labels see
Section 2B for instructions.
The image is printing horizontally offset
(White space is seen on the left or right side of the label)
Two printer driver settings can affect this issue. Left Margin Offset. This adjustment is found in the
Status Monitor. If you see white space on the right side of the label and overlap on the opposite
side, increase the number. If you see white space on the left side of the label and overlap on the
opposite side decrease the number (Negative numbers are allowed). Note: Usually a space on the
right side indicates a margin around the label that is not being accounted for. The Printer is factory
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calibrated for a 2mm margin. A larger margin around the label will cause a right side space. Page
Size. Often the page size is not large enough for the label. If this is the case you may see white space
on the right side of the label and no image overlap on the opposite side. This indicates that the page
size needs to be increased. Increase the page size through the printer preferences enough to cover
the label.

7B Solving Cut Alignment Offset Problems
Cut alignment is calibrated at the factory. However, it is possible that you may need to adjust the
cut line position for certain prints/cuts.
Adjust Cutter Offsets by opening Primera Print Hub. Go to the XY Cutter tab. Adjust cutter offsets
according to the diagram below. To move the cut to the right increase the Horizontal Offset. To
move the cut to the left decrease the Horizontal Offset. To move the cut up increase the Vertical
Offset. To move the cut down decrease the horizontal offset. Remember the top of your
document prints first so it prints upside down if you are standing in front of the Printer. You may
also use the “Send Test Print” button to assist you with this process.
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7C Maintenance
Replacing the Cutter Wear Strip
The wear strip is the surface directly underneath the cutting blade in the cutter mechanism. Over
time this strip will wear down due to cutter knife pressure. It can also be damaged if the knife cuts
through the liner and contacts the wear strip.
To replace the wear strip remove any media from the cutter mechanism. Power off the Printer.
Push the knife carrier gently to the left. Grab one end of the wear strip and pull it off the cutter. If
necessary, use a utility knife to get under the strip to start it. The wear strip is held in place with
adhesive so there may be adhesive residue. Clean off the adhesive with isopropyl alcohol.
Remove the liner from the new wear strip. Press the strip into place. Make sure it is fully seated in
the recessed pocket.

Wear Strip Location
(Red Color is only
meant to highlight
location)

Replacement Wear Strip Part Number 074549 (10 pack)
Label Cut Dust
Label cut dust can accumulate at any place along the cut path.
Paper media creates more dust than synthetic material. Dust build up does not cause any specific
immediate problems but it can eventually cause problems with the moving parts and electronics in
the cutter.
Periodically vacuum the cutter area and rollers.
Cleaning the Printer
The case of the Printer can be cleaned with an ammonia based window cleaner and a lint-free cloth.
Over time, ink overspray may gather at the base of the Printer. The Printer is designed using a
vacuum system to gather most of this ink on a series of saturation pads. Eventually, these pads may
need to be replaced. Contact tech support to determine if pad replacement is necessary.
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Ink Accumulation - Chutes
Ink build up can occur in the spit chutes that leads to the ink saturation pads. Pigment Ink tends to
build up faster than Dye Ink. Make sure there is a clear path for the ink to reach the pads below.
Partially dried ink can accumulate around the sides of the chute. Use a ridged flat edge such as a
pairing knife to scrap away the ink.

Ink Chutes

Ink Accumulation – Wipers (A software and firmware update may be required. Run the update
first)
If you notice that your print quality is poor at the beginning of a print but gets better as it continues
to print, your ink wipers may have accumulated a combination of cut dust and ink. Check the
wipers and clean them with rubbing alcohol and a cotton tip cleaner. Wipers are located on the
right side of the Printer but are normally hidden from view under the cartridge. You will need to put
the Printer in wiper maintenance mode.
1.
2.
3.
4.

Open the top cover.
Press and hold the pause button for 3 seconds until you see the print carriage move.
You will now have access to clean the wiper.
When complete close the cover.
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7D Cleaning the Output Cutter
Every 2000 cuts you will be prompted to clean the output cross cutter using a cleaning card. If you
have the card, you may follow the prompts to complete the cleaning procedure. Otherwise you can
purchase a pack of ten cleaning cards at the link below.
Cleaning Card 10 Pack – SKU 074550 - https://www.primera.com/output-cutter-cleaning-cards.html
To manually perform a cleaning in PrintHub, go to the Printer Settings tab – Advanced Settings –
Output Cutter Cleaning.
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Instructions:
Cleaning Cards are used to clean the output cutter wheel that cuts between each label or at the end
of a group of labels. If the cutting wheel cuts through continuous adhesive backed paper (such as
LX610 digital die cutting media), it can accumulate adhesive build-up that will eventually cause
cutting problems.
Recommend Cleaning Interval: Every 2000 Labels. PrintHub software tracks this and will alert you
when cleaning is necessary.

2. Locate the cleaning card.

1. Peel off the protective strip covering the
adhesive.

3. Unload label stock from the printer. Insert the 4. When the exposed adhesive strip is aligned with
cleaning card into the front output of the
the output cutter path, open PrintHub – Select
printer.
Printer Settings – Advanced. Click on Output
Cutter Cleaning. Once the cutter cycles, remove
both parts of the card from the printer.
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7E Cleaning the Cartridge – Poor Print Quality
It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you
suspect a cartridge nozzle has become slightly dried out or clogged. If the cartridge has been left out
of the Printer more than 30 minutes, the ink in the print head nozzles may have dried. If you are
having print quality problems, follow the steps below:
1. Before moving on to the next step, ensure that the ink level of the color cartridge is more
than 10%. If the ink level is lower than 10%, replace the cartridge.
2. Try cleaning the cartridge using the clean function in PrintHub.

3. Determine if printing is now acceptable by printing your image. If the sample has missing
colors or voids within a color strip, remove the cartridge from the Printer and proceed to
step 4.
4. Prepare items needed for procedure
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5. Soak the paper towels in water for 5 seconds.

6. Place one paper towel on cartridge nozzles. Gently press the paper towel with your finger.
Leave the paper towel on the nozzles for 30-40 seconds.
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7. Wipe nozzles.

a. Place second paper towel on flat/hard surface.
b. Press the nozzles into the paper towel.
c. Firmly tap the top of the cartridge three times to
force the ink out.
d. Wipe/Drag the cartridge in the direction indicated.
e. Repeat until all colors are seen on the paper towel.
After wiping the nozzles, the paper towel should
show all three colors. If all three colors are present,
proceed to step 8. If the paper towel doesn’t show
all three colors, then repeat step 7. If paper towel
still doesn't show all three colors repeating step 7,
then replace the cartridge.

8. Dry the cartridge.

Dry excess water from cartridge.
Ensure cartridge contacts are
completely dry. Printer damage may
result if cartridge contacts are not
completely dry.

9. Verify cartridge is now functioning properly by printing your label.
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7F Error Messages
•
•
•
•
•
•
•
•

XY Cutter Stall
Cutter Stall (Output)
Missing Cartridge, Invalid Cartridge, Incompatible Cartridge, Incorrect Cartridge, Cartridge
not installed correctly, or Cartridge Data Error
Label Stock not recognized
Paper Out Error
Unable to feed paper / media / stock on initial load. Printer will not grab the paper
PTCreate Pro crashes when importing a file or the file does not import correctly
My LX610 or LX600 is skipping, slipping, printing over on the same spot or printing out of
alignment left to right

7G Technical Support
If you have difficulties operating your Printer, contact technical support using one of the methods
listed below.
Source
Primera Knowledge Base

Location
www.primera.com/kb

Email Support

www.primera.com/customer-support

Phone Support

763-475-6669 (Mon - Fri 7 a.m. - 10 p.m CST
and Saturday 11 a.m. – 8 p.m.)

Chat

www.primera.com – see chat icon in lower
right corner (Mon - Fri 7 a.m. - 10 p.m CST
and Saturday 12 noon – 9 p.m.)
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Section 8: Technical Specifications
PRINT SPEED1
PRINT RESOLUTION
PRINT TECHNOLOGY
INK TYPES
Label Types
STANDARD CONNECTIVITY
Print Width
(Digital Die Cutting)
Print Width
(Pre-die cut)
Media Width

Pre-die cut media: Up to 4.5” per second
Digital die-cut speeds are dependent upon the image being cut
Up to 4800 x 1200 dpi
Thermal Inkjet
Dye-based CMY, Pigment CMY
Pre-die cut, continuous and black marks
USB 2.0 (USB 3.0 compatible)
0.5” (13mm) - 4.25” (108mm) Digital Die Cut media width is fixed
at 4.25” However, smaller size labels can be cut from the 4.25”
media. See Note on Page 17.
0.5” (13mm) - 5” (127mm)

Operating System
DIMENSIONS

Pre die-cut: 2.125" (54mm) to 5.125" (130mm)
Digital Die-cut: 4.75" (121mm) (4.25” Printable)
12” (305mm)
0.43" (11 mm)
Windows 7, 8 or 10 (64-bit Only) Mac OS 10.11 or higher
13.6 W x 17” D x 9.5” H (345mm W x 432mm D x 242mm H)

WEIGHT

12.5 lbs (5.7kg)

POWER

Input: 100 – 240 VAC, 50/60 Hz, 60 watts, Output: 12 volt 5 amp

WARRANTY
Operating Temperature

One-year parts and labor; lifetime phone, chat and email support
50 to 95º F (10 to 35º C)

Recommended Operating
Temperature
Storage Temperature
Operating Humidity

61 to 87º F (16 to 32º C)

Storage Humidity
Certifications
REPLACEMENT INK
CARTRIDGES

10 to 80% RH (non-condensing)
UL, UL-C, CE, FCC Class A
Primera Pigment 53491
Primera Dye 53496

Maximum Print Length
Gap Between Pages

-4 to 140º F (-20 to 60º C)
10 to 60% RH (non-condensing)

134

FCC

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.
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Environmental Policy
The European Union (EU) has developed the WEEE (Waste Electrical and Electronic Equipment) Directive
(WEEE Directive 2012/19/EU) to ensure that systems for collection, treatment, and recycling of electronic
waste will be in place throughout the European Union.
Electrical and electronic equipment (EEE) contains materials, components, and substances that may be
hazardous and present a risk to human health and the environment when waste and electronic equipment
(WEEE) is not handled correctly.

Equipment marked with the below crossed-out wheeled bin is Electrical and electronic equipment (EEE).

The crossed-out wheeled bin symbol indicates that the product is EEE and must be collected separately, in
accordance with the WEEE Directive 2012/19/EU.

Users of EEE must not discard WEEE together with household waste. Users must follow local recycling
regulations to reduce adverse environmental impacts in connection with disposal of WEEE and to increase
opportunities for reuse, recycling, and recovery of WEEE. As a user of this EEE, you have an important role in
recycling this equipment and contributing to the protection of the environment and the conserving of natural
resources.
When a product reached its end of life, contact us at environment@primera.com or +1-763-475-6676 to
arrange its recycling. Primera will work with you to arrange for the recycling of the product.

136

